
Displays the full MS-DOS Pathname of the Album Information File you are editing.



Enter the title of the album here.



Enter the name of the artist who is featured on the album here. If you do not specify an artist, the album's 
information will not be saved.



Enter a year for the album here. This usually contains the year in which the album was released, but you may 
specify any year here.



Enter the copyright information for the album here. It is recommended that you use the form, "(c) 19xx Record 
Company, Inc."



Enter the owner of the album here. The value of this field has no significance to DiscPlay.



Enter the category to store the album under here. The value of this field has no significance to DiscPlay.



Enter any miscellaneous information here. The value of this field has no significance to DiscPlay.



Contains the names of the tracks on the album. Click on a name to modify it in the edit box below.



Use this edit box to modify track names. To display a track's name for editing, click on the track in the list above. 
Edit the name in this box, and then press the Enter key to apply the changes.



Click this button to send the album’s title, artist, and track titles for inclusion in the xmcd-cddb database. The 
information will be included in the next update of the database. The database is updated about once every 2-3 
months.



Enter comments or miscellaneous data here.



Enter the MS-DOS Pathname here of the file to be automatically opened each time this album is inserted. This 
may be an application or a document file.



Click this button to use the standard Open File dialog box to locate a file to automatically open.



Use this menu to specify what type of window you'd like the file to appear in.



Click this button to close the window and save any changes.



Click this button to close the window without saving any changes.



Click this button to save any changes you have made without closing the window.



Click this button to clear all statistical data for this album.



Displays the number of times each track on this album has been played and how that number ranks against 
other tracks on the album.



Check this box if you’d like the album to be alphabetized last-name-first in the Collection Properties window.



Click this button to attempt to get this album’s title, artist, and track titles from the remote xmcd-cddb server.



Displays the titles and URLs of all web sites associated with this album. Double-click an item to edit its title and 
URL.



Click this button to add a new site to the list.



Click this button to edit the currently-highlighted item.



Click this button to delete the currently-highlighted item.



Click this button to make the currently-highlighted item the default WebLink. The default WebLink can be 
accessed by double-clicking the WebLink icon on DiscPlay’s main window. The default WebLink can also be set to 
open automatically whenever you insert the album.



If this item is checked, DiscPlay will automatically open the default WebLink whenever you insert this album.
Note:

Settings under the WebLink tab of the Options window may be used to override this setting.



Click on a section to sort the list based on that item. You may also resize the sections by dragging the dividers 
between them.



Displays the title, artist, and year of each album in your collection. Double-click an album in this list to modify its 
properties.



Click this button to print the entire collection or the selected album.



Click this button to export the entire collection to an ASCII database file. The file created will contain the title, 
artist, year, copyright, category, owner, miscellaneous data, and track names, with these fields separated by 
tabs. Albums are separated by returns.



Click this button to open the Album Properties window for the currently-selected album in the list. You may also 
double-click an album in the list to do this.



Click this button to remove the currently-selected album from your collection. The associated album information 
file will be deleted.
Note:

You cannot remove an album that is currently inserted in the CD drive.



Displays the full MS-DOS Pathname of the currently-selected album in the list.



Click an item in this list to choose an item to search for.



Enter the text to search for in this box.



If this item is checked, an item will match only if it contains the specified text not immediately surrounded by any
other text.



Click this button to begin the search.



Click on a section to sort the list based on that item. You may also resize the sections by dragging the dividers 
between them.



This list contains any matches that were found during the last search.
Notes:

If the search was album-based, double click an item to open an Album Properties window.
If the search was track-based, double click an item to display some additional information about the track.



Click this button to open an Album Properties or Track Information window for the currently-selected item in the 
list.



Click this button to print all albums represented in the search results, or only the album represented by the 
currently-selected item.



Click this button to close the Collection Properties window.



Click this button to open your album folder(s) in Windows Explorer.



Displays information on the most-played albums in your collection. This ranking is based on number of times 
each album has been inserted.



Click this button to calculate track rankings.



Displays information on the most-played tracks in your collection.
Note:

You can double-click on tracks in this list for more information.





What Is DiscPlay?
DiscPlay is a shareware audio CD player for Windows 95 and Windows NT. It builds on the capabilities of other 
CD player utilities by adding such features as:

An integrated collection-management facility, accessible via the Collection Properties window.
Custom playlists for "programmed" playback. You may create virtually any number of custom playlists for 

each album. You may also add partial tracks to your custom playlists.
Access to 12,000-album xmcd-cddb database. The database can be accessed locally, or from the Internet.
Built-in collection searching and printing.
Extensive options for customizing the program's look and feel.

DiscPlay is also very inexpensive. The registration fee is $8.00US.



How Do I Register DiscPlay?
You are allowed to use DiscPlay free of charge for a period of up to 30 days. After this 30-day trial period, you 
must either register DiscPlay or remove it from your computer. 
There are two ways to register DiscPlay: either by using your credit card and the DiscPlay On-line Registration 
web site (the cost is $10.00US per registration when paid on-line), or by sending the registration form 
(ORDER.RTF) and a check or money order via postal mail (the cost is $8.00US per registration when paid by 
mail).
Further Information:

How To Register By Mail
How To Register On-Line



How To Register By Mail
If you do not choose to register on-line with your credit card, you may also register by postal mail. Although this 
takes significantly longer than on-line registration, you should still have your registration information within 1-2 
weeks. There is also a $2.00US discount for those who register by mail, so the cost is a total of $8.00US per 
registration--as opposed to $10.00US for on-line credit card registration.
To register by postal mail, follow these steps:
1 Print the order form, ORDER.RTF. You can use any RTF-compatible word processor, such as Microsoft Word or 

the Windows 95 WordPad utility. If you copied ORDER.RTF into the same directory DISCPLAY.EXE is installed in, 
you may print the file by clicking "Print Order Form" under DiscPlay's "Help" menu.

2 On the order form, fill out sections A, B, C, and D (Note that C and D are optional).
3 Send the order form and payment to the address printed at the top of the form.
After your payment and order form are received, you will be sent a password and serial number. If you supplied 
an e-mail address on the order form, the information will be sent to that address. If you did not supply an e-mail 
address, the information will be snail-mailed to you.
When you receive the password and serial number, follow these steps:
1 Click "Register..." under DiscPlay's "Help" menu.
2 When the "Register DiscPlay" window appears, click the "Next >" button.
3 Enter the password and serial number you received, your name, and your organization's name in the 

appropriate boxes.
4 If you entered the password and serial number correctly, the "Register" button will be highlighted. Click it to 

complete the registration process.
Note:

Please read and follow all instructions on the registration form!



How To Register On-Line
If you have access to the World Wide Web, you may register DiscPlay on-line. The cost is $10.00US per 
registration, which will be charged to your credit card.
To register on-line, follow these steps:
1 In a forms-compatible web browser (such as Netscape Navigator or Microsoft Internet Explorer), open the 

following URL:
http://www.pobox.com/~discplay/32/register

2 Read all instructions on the left side of the form.
3 Fill out all the appropriate items on the right side of the form.
4 When you're sure you have entered all information correctly, click the "Continue" button at the bottom of the 

form.
5 You will be presented with another form on which to enter your credit card information. Enter your card number

and expiration date, and then click “Purchase”.
6 You will be sent a confirmation e-mail in 1-4 days.
About 1-4 days after your receive the confirmation e-mail, you will be sent a password and serial number.
When you receive the password and serial number, follow these steps:
1 Click "Register..." under DiscPlay's "Help" menu.
2 When the "Register DiscPlay" window appears, click the "Next >" button.
3 Enter the password and serial number you received, your name and your organization's name in the 

appropriate boxes.
4 If you entered the password and serial number correctly, the "Register" button will be highlighted. Click it to 

complete the registration process.



The registration fee is $8.00US when you pay by postal mail. You may pay by check, money order, or cash, but 
keep these notes in mind:

Checks must be in US funds drawn on a US bank.
International money orders must be in US dollars.
Cash must be US dollars. If you send cash, be sure it cannot be seen through the envelope. You may 

want to wrap it up in dark-colored paper or use a security envelope.



What Is A Playlist?
A playlist is a list of steps that DiscPlay will play. Each step represents either a track or a partial track on the 
album. Playlists are synonymous with programmed playback on a home stereo CD player.
DiscPlay automatically creates a single playlist, named "Album," for each album you insert. The Album playlist 
contains a step for each track on the album. In addition to this playlist, you may create any number of custom 
playlists.
Further Information:
               Selecting Playlists  
               Creating Playlists  
               Modifying Playlists  
               Removing Playlists  



How To Select A Playlist
Each playlist is represented by a tab located directly below the current playlist. To select a playlist, simply click 
on its tab.



How To Create A New Playlist
To create a playlist, click the Add Playlist  button. You will be presented with a window asking you to enter a 
name for the playlist. Type a name and click the OK button.
Notes:

The playlist name can be up to 255 characters in length, but you should keep the name short so it fits onto
a tab.

There must not already be a playlist by the name you enter.
Add steps (tracks) to the playlist by dragging them from other playlists onto the new playlist's tab, or by 

clicking the Track List button 
 and dragging them onto the playlist from the Track List window.



How To Modify An Existing Playlist
DiscPlay allows you to modify any playlist at any time. You may rename a playlist by clicking the Rename Playlist 
button . In addition, there are several other ways to modify playlists:
Adding Steps To A Playlist

Drag a step from another playlist or the Track List window onto the a playlist's tab to add the step to the 
end of the playlist.

Drag a step from the Track List window to any position in the current playlist to insert the step.
Moving Steps Within A Playlist

Drag steps within the current playlist to re-order them.
Removing Steps From A Playlist

Drag a step onto the delete button to remove it.



How To Remove A Playlist
To remove a playlist, select it and click the Remove button.
Note:

You cannot remove the Album playlist.



What Is The xmcd-cddb Database?
The xmcd-cddb database is a large collection of album information (12,000+ albums) that DiscPlay can access 
locally or via the Internet.
This database allows you to obtain album titles, artists, and track names from the Internet so that you don’t have
to enter them by hand. To get album information from the remote xmcd-cddb database server, simply click the 
Get From Internet button in the Add New Album wizard. To send information to the database, click the Send To 
Internet button in the Album Properties window.
DiscPlay can also use the xmcd-cddb database locally if you download it onto your computer. For instructions on 
how to use the database locally, see How To Use The xmcd-cddb Database Locally.
Note:

If you set Always query the remote xmcd-cddb server when a new album is inserted in the Options 
window, DiscPlay will automatically attempt to load information from the remote xmcd-cddb database server every 
time you insert a new album.



How To Use The xmcd-cddb Database Locally
If you download the entire xmcd-cddb database, DiscPlay can access it without requiring an active Internet 
connection. You can download the latest version of the xmcd-cddb database from DiscPlay’s web site at 
http://www.pobox.com/~discplay/32/cddb.html. The file is about 3MB in size (10MB when unzipped).
Once you’ve downloaded the database, follow these steps to allow DiscPlay to access it:
1 Copy the database ZIP archive into a temporary directory and unzip it. You must use your unzipping program’s 
“Restore folders” or equivalent option so that the extracted files are placed into separate folders.

2 Create a new folder called “xmcd-cddb” (without the quotes) inside the folder you installed DiscPlay in (usually 
C:\Program Files\DiscPlay).

3 If you had the unzipping options set correctly, a series of sub-folders were created within the temporary folder. 
They will be called “Rock”, “Soundtrack”, “Country”, and so on. Copy these folders into the “xmcd-cddb” folder 
you created.

If you followed these steps correctly, DiscPlay will now search the xmcd-cddb database files on your hard drive 
whenever you insert a new CD.
Note:

If you’d like to store the xmcd-cddb files in a different directory, you can do so by changing the path 
specified under the Miscellaneous tab of the Options window.



How To Send Album Information To The Internet
DiscPlay allows you to send your album information for inclusion in the xmcd-cddb database. This allows others 
to download your information so they don’t have to enter it manually. The information will be available to users of
any CD player utility that supports the xmcd-cddb database.
Before you can send information to the Internet, you must set a couple options in the Options window. Under the 
Internet tab, you must enter the name of your Internet provider’s outgoing mail (SMTP) server, and you must also
enter your full Internet e-mail address. See your Internet provider’s documentation for information on your e-mail
address and SMTP server.
You must also be connected to the Internet to send album information. You can be connected either directly or 
though Dial-Up Networking.
When you are connected to the Internet and have all options set properly, follow these steps to send album 
information:
1 Open the Collection Properties window and double-click on the album whose information you wish to upload.
2 When the album’s Album Properties window appears, click on the Advanced tab.
3 Under the Advanced tab, click “Send To Internet”.
4 DiscPlay will now attempt to send the information. It will prompt you if it needs any additional information.
Note:

The album information will usually be added to the database within 2-3 days.



How To Get Album Information From The Internet
DiscPlay can retrieve album information including title, artist, and track titles from the Internet. It does this by 
querying a remote xmcd-cddb database server across a standard TCP/IP connection.
To allow DiscPlay to get information, you must be connected to the Internet. You can be connected directly or 
through a Dial-Up Networking connection. For information on how to connect to the Internet, see Windows’ help 
and your Internet provider’s documentation.
Once you’re connected to the Internet, follow these steps to attempt to get album information from the Internet:
1 Insert the CD you intend to get information on. This will automatically bring up DiscPlay’s Add New Album 

wizard.
2 When the Add New Album wizard appears, click the Get From Internet button.
3 DiscPlay will now attempt to query the remote xmcd-cddb server. It will prompt you if it needs any additional 

information.
Note:

If you set Always query the remote xmcd-cddb server when a new album is inserted in the Options     
window, DiscPlay will automatically attempt to load information from the remote xmcd-cddb database server every 
time you insert a new album.



How To Print Your Collection
DiscPlay allows you to print single albums, search results, or your entire collection.
To print a single album, follow these steps:
1 Open the Collection Properties window.
2 In the album list, highlight the album you want to print.
3 Click the Print button.
4 When the Print window appears, make sure Print selected album only is checked.
5 Click the Print button.
To print search results, follow these steps:
1 Click the Print button located directly below the Search Results list.
2 When the Print window appears, make sure Print selected album only is not checked.
3 Click the Print button.
To print your entire collection, follow these steps:
1 Open the Collection Properties window.
2 Click the Print button located directly below the album list.
3 When the Print window appears, make sure Print selected album only is not checked.
4 Click the Print button.



What’s New In DiscPlay 3.4
DiscPlay 3.4 contains numerous additions and enhancements over earlier versions of the program. Here is a 
short list of some of the most important ones:

Album and track rankings are now available under the Statistics tab of the Options window.
Support for local xmcd-cddb database files has been improved.
The system tray pop-up menu has been expanded to allow jumping directly to specific tracks.
The WebLink feature allows you to automatically open artists’ web sites in your web browser—and DiscPlay

can even query the Internet search engine of your choice to find sites.
The registration system has been improved. You can now register with your credit card!



Tips For Upgrading To DiscPlay 3.4
This help topic provides tips for users of earlier versions of DiscPlay who are upgrading to version 3.4.
Use your DiscPlay 2.x album information files.

You can either copy your old album information (.DPD) files into DiscPlay 3.4’s Album Files folder, or you 
can add your DiscPlay 2.x album folder to the album search path (see Options window for more information).
Use your DiscPlay 2.x print template files.

You can open DiscPlay 2.x print template (.DPT) files just as you would open DiscPlay 3.4 templates.



Player Window
The Player window is DiscPlay's main window. It allows you to control playback and manipulate playlists.
The Player window opens automatically whenever you start DiscPlay.
For help on a specific item in the Player window, tab to it and press the F1 key.



Album Properties Window
The Album Properties window allows you to specify such information as an album's artist, title, copyright, and 
track names. The Advanced tab also gives you access to the xmcd-cddb database.
To open the Album Properties window, click "Album Properties" under the File menu.
For help on a specific item in the Album Properties window, click on the ? icon on the window's title bar, then 
click the item you'd like help on.
Note:

If you are using Windows NT 3.x, tab to the item you'd like help on and press the F1 key.



Collection Properties Window
The Collection Properties window allows you to view, manipulate, search, and print your album collection.
To open the Collection Properties window, click "Collection Properties" under the File menu.
For help on a specific item in the Collection Properties window, click on the ? icon on the window's title bar, then 
click the item you'd like help on.
Note:

If you are using Windows NT 3.x, tab to the item you'd like help on and press the F1 key.



Print Window
The Print window allows you to set options, select a template, and specify the scope for a print operation. It also 
provides space for you to edit print templates.
To open the Print window, click "Print Album" under the File menu, or click the Print button in the Collection 
Properties window.
For help on a specific item in the Print window, click on the ? icon on the window's title bar, then click the item 
you'd like help on.
Note:

If you are using Windows NT 3.x, tab to the item you'd like help on and press the F1 key.



Options Window
The Options window allows you to customize certain aspects of how DiscPlay looks and operates. You specify 
display options, folders in the search path, and format strings with this window.
To open the Options window, click "Options" under the Window menu.
For help on a specific item in the Options window, click on the ? icon on the window's title bar, then click the item
you'd like help on.
Note:

If you are using Windows NT 3.x, tab to the item you'd like help on and press the F1 key.



Enter any miscellaneous information for the track here. For example, you could enter the track’s artist here if the 
album is a compilation of works from various artists.



Click this button to display the previous screen.



Click this button to display the next screen.



Click this button to close the New Album Wizard and save the information you've entered.



Click this button to close the New Album Wizard and discard any information you've entered.



Enter the album's title here.



Enter the name of the artist featured on the album here.
Note:

Click the down-arrow to choose the artist from a list of all artists in your collection.



Enter the category to store this album under here. The contents of this field have no significance to DiscPlay.
Note:

Click the down-arrow to choose the category from a list of all categories in your collection.



Enter the name of the album's owner here.
Note:

Click the down-arrow to choose the owner from a list of all owners in your collection.



Enter a year for the album here. This usually contains the year in which the album was released, but you may 
specify any year here.



Enter the album's copyright information here. It is recommended that you use the form, "(c) 19xx Record 
Company, Inc."



Enter any miscellaneous information here. The contents of this field have no significance to DiscPlay.



Enter the name of the specified track here. After you enter the name, click the "Next Track >" button to name the
next track. Repeat this procedure until all tracks have been named.



Click this button to view or modify the name of the previous track.



Click this button to view or modify the name of the next track.



Click this button to search the remote database server for the album information. If the information is found, 
DiscPlay will download the album title, artist, and track titles so that you don’t have to enter them by hand.



Click this button to search the local xmcd-cddb database files for the album information.



If this artist or album has an associated web site, enter its URL here. You can open the URL by clicking the 
WebLink icon on the main window, or by selecting “Open WebLink” from the menu.
Notes:

For WebLink to work, you must have a browser that can handle Internet shortcuts (such as Netscape 
Navigator 2.0 or later, or Microsoft Internet Explorer 2.0 or later) installed on your system.

If you do not specify a URL here, DiscPlay will query the AltaVista search engine on the artist’s name when 
you click WebLink.



Enter a title for the step here. If you leave this box blank, the corresponding track's name will be used.



Displays the number of the physical track the step will play.



Enter the starting time within the physical track here.
Examples:

00:00 would start playing at the beginning of the track.
01:00 would start playing from 1 minute into the track.



Enter the ending time within the physical track here.
Examples:

In a track that is 5:34 in length, 05:34 would play until the end of the track.
In the same 5:34-length track, 04:34 would play until 1 minute before the end of the track.



Click this button to close the window and save any changes you have made.



Click this button to close the window and discard any changes you have made.



Click this button to display information on how to register DiscPlay.



Type the flashing password into this box to use DiscPlay before it is registered.



Click this button to begin using DiscPlay.
Note:

This button will be disabled until you type the flashing password into the edit box.



Click this button to close DiscPlay.



Enter the password you received when you registered here.
Note:

You must enter the password exactly as it appears in your registration materials. It is case-sensitive.



Enter the serial number you received when you registered here.
Note:

You must enter the serial number exactly as it appears in your registration materials. It is case-sensitive.



Enter your name here.



Enter your organization's name here.



Click this button to show the previous screen.



Click this button to show the next screen.



Click this button to close the window and accept the registration information you have entered.
Note:

This button will be disabled until you enter the password and serial number correctly.



Click this button to close the window without entering your registration information.



Click this button to close the window.



If this box is checked, DiscPlay will only print the album that is highlighted in the collection list or search results 
list.
Note:

This box will be disabled if you have not highlighted an album in the list, or if you are printing a single 
album by using Print Album under the File menu.



Displays the full MS-DOS Pathname of the template that will be used to print the album(s).
Note:

To use a different template, click the Browse button.



Click this button to create or choose a print template (.DPT) file.



If this box is checked, DiscPlay will not allow an album to be split between multiple pages.



If this box is checked, DiscPlay will print only one album per page.



If this box is checked, DiscPlay will print a header on each page. The header is defined in the current print 
template.



Displays a sample of what the base font for the printout looks like.
Note:

Effects such as boldface, italics, and underlining are controlled by the current print template and will not 
be displayed here.



Click this button to choose a new base font.
Note:

You may choose a font face and size, but effects such as boldface, italics, and underlining are controlled by
the current print template.



Displays the full MS-DOS Pathname of the print template you are editing. This is the template currently selected 
under the Options tab.
Notes:

To choose a different (existing) template, click the Browse button located under the Options tab.
To create a new template, click the Browse button located under the Options tab, enter a name for the 

template file, and click the Open button. When you are asked if you'd like to create a new file, click Yes.



Controls the format of the template's header, which is printed on the top of each page of output.



Controls the format of the template's body, which is printed once for each album.



Click this button to save any changes you have made to the template.



Click this button to close the window and begin printing.



Click this button to close the window without printing.



Print Templates
DiscPlay's Print window allows you to create custom print templates. These templates dictate what will be printed
in a line-by-line fashion. Please note that creating print templates is a topic for advanced users--for most, the 
default template and the compact template (COMPACT.DPT) supplied with DiscPlay 3.4 should suffice.

Contents of a Print Template
A print template consists of two separate parts: the header format and the body format.

The header format and body format are simply lists of zero or more format lines (see Layout of Format 
Lines, below).

The options simply consist of the states of the Do not allow page breaks within album body, Print only one 
album per page, and Print header checkboxes in the Print window.

Layout of Format Lines
Syntax:
t[as_][as_]...[as_]

Definition:
The first character of any line (t, above) specifies the line type. This can be any of three possible characters:
> Lines of this type are printed once per album (in the header, all non-divider lines must begin with this 

character).
} Lines of this type are printed once per track per album.
- Lines of this type print a horizontal divider. Any characters after the "-" are ignored.
A series of zero or more item blocks ([as_], above) follow the type character. Item blocks have the format [as_],
where:
[,] Enclose the block data.
a Specifies the alignment of the block. This character has three possible values:
l The block is aligned with the left margin.
r The block is aligned with the right margin.
c The block is centered.

s Specifies the style of the block. This character has four possible values:
p Plain.
b Bold.
i Italic.
u Underline.

_ Text and information tokens to print. Characters preceded by a percent-sign (%) are replaced with data 
dynamically (see Print Tokens); all other characters are printed as-is.

Example of a Print Template
To illustrate, look at the default print template:
Header Format:

>[lb%P Collection Report][lp (%C Albums)][cp%d][rpPage %p]
-

Interpreting the Header Format:
The header format has two lines: a printing line (notice ">" is the first character), and a dividing line ("-" is the 
first character).

The first line has four item blocks: [lb%P Collection Report], [lp (%C Albums)], [cp%d], and [rpPage %p].
The first item block, [lb%P Collection Report], will print DiscPlay Collection Report in bold type, left-aligned.
The second item block, [lp (%C Albums)], will print    (n Albums) in plain type, left-aligned.
The third item block, [cp%d], will print mm-dd-yyyy in plain type, centered.
The final item block, [rpPage %p], will print Page n in plain type, right-aligned.



The second line will print a horizontal divider.
The actual header printed will look something like this:

DiscPlay Collection Report (31 Albums) 09-Jan-1996 Page 1
Body Format:

>[lb%T]
>[lp%A]
}[li          %n. %t (%l)]
>
-
>

Interpreting the Body Format:
The body format has six lines: four album lines (those starting with ">"), one track line (starts with "}"), and a 
divider line.

The first line has a single item block, [lb%T], which prints Album's Title in bold type, left aligned.
The second line has a single item block, [lp%A], which prints Album's Artist in plain type, left aligned.
The third line, which is a track line, has a single item block [li     %n. %t (%l)], which prints

n. Title (mm:ss) once for each track on the album.
The fourth line is an album line that contains no item blocks, so it prints a blank line.
The fifth line prints a divider (notice "-" is the first character of the line).
The final line, like the fourth, simply prints a blank line.
The actual body printed will look something like this:

Album 1 Title
Album 1 Artist
     1. Track 1 Name (0:00)
     2. Track 2 Name (1:00)
     3. Track 3 Name (2:00)

Album 2 Title
Album 2 Artist
     1. Track 1 Name (3:00)
     2. Track 2 Name (4:00)
     3. Track 3 Name (5:00)
     4. Track 4 Name (6:00)



Print Tokens
Print Tokens are characters in a print template format line that are preceded by a percent sign (%). They are 
replaced with the corresponding information in the following table:

Token Replaced with
Miscellaneous tokens (use in the header)

%C Number of albums in the collection
%d The date when printing began
%P DiscPlay
%p Page number
%V 3.4

Album-related tokens (use in > lines)
%A Artist
%c Number of tracks
%L Length (mm:ss)
%G Category
%N Album number (1 through number of albums in the collection)
%O Owner
%R Copyright
%T Title
%U User data
%Y Year
%0 First line of comments
... ...
%9 Tenth line of comments

Track-related tokens (use in } lines)
%l Length (m:ss)
%n Number (1 through number of tracks on the album)
%o Miscellaneous (“Other”)
%t Title



Dialogs
You have selected an album in the Collection Properties window and clicked the Remove button.
Buttons:

Yes: Remove the album from the collection by deleting its album information file.
No: Don't delete the album.
Help: Show this help screen.



Dialogs
You specified an album information file that is not in the list of folders DiscPlay searches whenever an album is 
inserted.
Buttons:

Yes: The folder containing the album information file will be added to the list of folders to search.
No: The folder will not be added. You will have to find the file manually again the next time you insert the 

album.
Help: Show this help screen.



Dialogs
The file you have specified to automatically open when the album is inserted was not found. Check the Pathname
specified under the Advanced tab of the Album Properties window.



Dialogs
You specified an album information file that was not associated with the album you inserted.
Buttons:

Yes: The Open dialog will be shown again to let you pick another file.
No: The program will proceed as if this were a new album.
Help: Show this help screen.



Dialogs
DiscPlay could not start-up properly because it experienced an error while trying to get control of the CD drive.
Possible Causes:

Another CD player utility may be active. Close the other utility and click Retry.
Your CD Audio drivers may not be set up properly. See Windows' help for information on setting up your 

drivers.
Buttons:

Abort: The program will terminate.
Retry: The program will try to get control of the drive again.
Help: Show this help screen.



Dialogs
You dropped a file onto DiscPlay's window that is not an album information file, so it does not know what to do 
with the file.
Buttons:

Yes: The file will be automatically opened each time you insert the album that is currently in the drive.
No: The dropped file will be ignored.



Dialogs
You attempted to close DiscPlay while playback was occurring.
Buttons:

Yes: Playback will be stopped and the program will terminate.
No: The program will terminate without stopping playback. Playback will continue until the current step 

finishes.
Cancel: The program will not terminate.
Help: Show this help screen.

Note:
To make the program always stop playback without displaying this dialog, set Always stop playback before 

exiting the program    in the Options window.



Dialogs
You either started DiscPlay with the "/PLAY" command-line switch, or had Automatically start playback when an 
album is inserted checked in the Options window--but the album's current playlist was empty.



Dialogs
You inserted a CD that contains only one track. This usually means it is a CD-ROM, which cannot be used by 
DiscPlay.
Buttons:

Yes: DiscPlay will assume that it is an audio CD, and proceed as usual.
No: The CD will be ignored. DiscPlay will look as it does when the drive is empty.
Help: Show this help screen.



Dialogs
You tried to print, but the printer was inaccessible.
Possible Causes:

The printer may be turned off.
You may not have a printer selected or attached to the computer.



Format Strings
Format Strings allow you to specify what text is displayed in the title bar and user information bar of the Player 
window. The format string is simply a line of regular characters and status tokens (characters preceded by a 
percent sign). The status tokens are replaced with information dynamically; the regular characters are copied as-
is.
Note:

Status tokens and characters enclosed in braces ( {,} ) are displayed only when there is not a disc in the 
CD drive.

Status tokens and characters enclosed in brackets ( [,] ) are displayed only when there is a disc in the 
drive.

Other status tokens and characters are always displayed, regardless of whether there is a disc in the drive.
Examples:

%P %V Displays DiscPlay 3.4 whether there is a disc in the drive or not.
{No }Disc. Displays Disc. when there is a disc in the drive, No Disc. when there isn't.
[%t (%A)]{No disc.} Displays Track Name (Artist) when there is a disc in the drive, No disc. 

when there isn't.



Status Tokens
Status Tokens are characters in a format string (see Options window) that are preceded by a percent sign (%). 
They are replaced with the corresponding information in the following table:

Token Replaced with
Miscellaneous tokens

%C Number of steps in the current playlist
%L Playlist title
%N Playlist item number
%P DiscPlay
%V 3.4

Album-related tokens
%A Artist
%G Category
%O Owner
%R Copyright
%T Title
%Y Year
%0 First line of comments
... ...
%9 Tenth line of comments

Track-related tokens
%m Minutes elapsed/remaining
%n Track number
%o Miscellaneous (“Other”)
%s Seconds elapsed/remaining
%t Title



If this item is checked, DiscPlay will automatically request album information when you insert an unrecognized 
album.
Note:

If When requesting new album information, use the New Album Wizard is checked, DiscPlay will request 
information using the New Album Wizard. If it is not checked, it will use the Album Properties window.



If this item is checked, DiscPlay will use the New Album Wizard instead of the Album Properties window when 
requesting new album information.



If this item is checked, DiscPlay will ignore insertions of single-track CDs without prompting the user for an action
to take.
Note:

Single-track CDs are usually CD-ROMs, which cannot be used by DiscPlay.



If this item is checked, DiscPlay will use a default Pathname for newly-created album information files. If it is not 
checked, you will be asked to specify a Pathname each time a new album is inserted.



If this item is checked, DiscPlay will automatically stop playback when you exit the program. If it is not checked, 
you will be prompted for an action to take.



If this item is checked, DiscPlay will automatically start playback whenever you insert a CD.



If this item is checked, DiscPlay will not automatically start playback if there is a CD in the drive when you start 
the program.



Specify the number of seconds of each step to play in intro mode here.



Specify an action to take when the user double-clicks an item in the playlist here.
Actions:

Open the Step Properties window for the double-clicked step.
Begin playing the step.



If this item is checked, a pop-up description will appear whenever you stop the mouse cursor over a control on 
the Player window.



If this item is checked, the time indicator will show the time remaining in the current track. If it is not checked, 
the elapsed time will be shown.



If this item is checked, DiscPlay's menu bar will be visible.



If this item is checked, the Player window's position will be saved and restored each time you start DiscPlay. If it 
is not checked, the window will be centered on the screen.



If this item is checked, the Player window's size (full, playlist, detail, control, or mini) will be saved and restored 
each time you start DiscPlay. If it is not checked, the window will always appear in full size.



If this item is checked, the Player window will stay in front of all other windows on the screen.
Note:

If any other DiscPlay windows are open (such as an Album Properties window), the setting will have no 
effect until they are closed.



If this item is checked, the current step in the playlist will be highlighted in red.



If this item is checked, the playlist will automatically scroll to keep the current step in view.
Note:

The steps immediately surrounding the current one will also be kept in view.



The Player window will "stick" to the screen border(s) you select.
Note:

To keep the window in a corner of the screen, select a horizontal and a vertical border.



If this item is checked, an eject button will appear in the system notification tray (Taskbar).



If this item is checked, a stop button will appear in the system notification tray (Taskbar).



If this item is checked, a play/pause button will appear in the system notification tray (Taskbar).



If this item is checked, a previous track button will appear in the system notification tray (Taskbar).



If this item is checked, a next track button will appear in the system notification tray (Taskbar).



If this item is checked, a DiscPlay icon will appear in the system notification tray (Taskbar).
Notes:

Left-click the DiscPlay tray icon to bring the Player window to the front.
Right-click the DiscPlay tray icon to pop-up the Control menu.



Displays a list of the folders that DiscPlay will search for album information files when you insert a CD.



Click this button to remove the highlighted folder from the search path.



Click this button to manually add another folder to the search path.



If this item is checked, DiscPlay will automatically add folders you open while manually locating album 
information files.
Note:

The setting of this item will have no effect if Always use default filename for new album information files is 
checked under the General tab.



Displays the folder DiscPlay will create new album information files in. To specify a different folder, click the 
Browse button.



Click this button to change the default new album folder.



Displays the format string that dictates what is displayed on the title bar of the Player window.



Displays the format string that dictates what is displayed on the user information bar, which is located directly 
below the time indicator on the Player window. This text will also appear when the mouse pointer is stopped over 
DiscPlay’s notification tray icon.



Displays the address of the remote xmcd-cddb database server to use. There are several servers in operation on 
the Internet--click on the one nearest you on the world map.



Displays the geographic location of the currently-selected remote xmcd-cddb database server.



If this item is checked, DiscPlay will attempt to load album information from the remote xmcd-cddb database 
server whenever you insert a new album.



Click this button to close the Options window and save any changes you have made.



Click this button to close the Options window without saving any changes you have made.



Click this button to save any changes you have made, without closing the window.



Displays your full Internet e-mail address. This is needed when you send information to the xmcd-cddb database.



Displays the name (or numerical IP address) of your Internet Service Provider’s outgoing mail (SMTP) server. This 
is needed when you send information to the xmcd-cddb database.
Note:

Please see your service provider’s documentation If you don’t know the name of your outgoing mail server.



If this item is checked, DiscPlay will automatically shuffle the playlist whenever you switch playlists or insert a 
CD.



Format strings allow you to control what DiscPlay displays in certain parts of its window; however, their use can 
decrease the performance of your computer. If this option is not checked, default displays will be used to 
conserve CPU resources.



Displays the path of the local xmcd-cddb database on your computer. This is needed only if you are using the 
database locally instead of across the Internet.



Click this button to change the local xmcd-cddb path.



If this item is checked, DiscPlay will automatically scan the local xmcd-cddb database whenever you insert a new 
album.



If this item is checked, DiscPlay will always start minimized.



These items allow you to specify how default WebLinks are handled.
Note:

The first two options will override individual albums’ default WebLink settings.



These items allow you to specify which Internet search engine to use when you click “Search” under the WebLink 
menu.



Opens the Collection Properties window.



Opens the volume-control application (by default, this is Windows' standard Volume Control, SNDVOL32.EXE).



Ejects or retracts the CD drive's tray.



Stops playback and moves to the beginning of the first step in the playlist.



Starts or pauses playback.



If fewer than 2 seconds have elapsed in playback of a step, moves to the previous step in the playlist. Otherwise,
moves playback to the beginning of the current step.



Moves playback to the beginning of the next step in the playlist.



Displays the current playback position within the current step. Drag the scroll thumb to a different location to 
jump to another part of the step.



Displays the steps in the current playlist.
Notes:

Drag steps within this list to re-order them.
Drag tracks from the Track List window onto this list to add them to the playlist.
Drag steps from this list onto a different playlist's tab to add them to that playlist.
Drag steps from this list onto the Delete button to remove them.



Click this button to remove the current playlist.
Note:

You cannot remove the "Album" playlist.



Click this button to create a new custom playlist.



Click this button to rename the playlist.



Click this button to shuffle the steps in the current playlist.
Note:

Drag a single step onto this button to randomize the location of that step only.



Click this button to delete the currently-selected step from the playlist.
Note:

You may also drag a step onto this button to delete it.



Click this button to change the starting position, ending position, and title of the currently-selected step in the 
playlist.



Click this button to display the Track List window.



Click this button to open an Album Properties window for the currently-inserted album.



Enter a name for the new playlist here. The name can be anything up to 255 characters, but you should keep it 
as short as possible so there is room for the name on the playlist’s tab.



This list contains an item for each track on the album. Drag tracks onto the playlist to add them; drag tracks from
the playlist onto this list to remove them.



This list contains an item for each track in the playlist you’re creating. Drag tracks from the album list to add 
them; drag tracks from this list to the album list to remove them. You can also re-order the tracks by dragging 
them around within this list.



If this item is selected, DiscPlay creates the playlist with tracks placed in random order.



If this item is selected, DiscPlay creates the playlist with tracks placed in the order that you specified.



Click this button to show the previous step.



Click this button to show the next step.



Click this button to create the playlist and continue.



Click this button to close the window without creating a new playlist.



Select this option to manually create the playlist. You will be prompted to pick tracks from a list.



Enter the number of tracks to include in the automatically-generated playlist here. For example, if you enter “7” 
here, DiscPlay will generate a playlist that contains the seven most-played tracks on the album.



Select this option to have DiscPlay automatically create a playlist of the most-played tracks on the album.
Note:

The statistical data that DiscPlay uses to build this playlist is visible under the Statistics tab of the Album 
Properties window.



Enter the name (or numerical IP address) of your Internet Service Provider’s outgoing mail (SMTP) server here. 
This address is needed when DiscPlay uploads information to the xmcd-cddb database.
Note:

Please see your Internet provider’s documentation if you don’t know your SMTP server’s name or IP 
address.



Enter your complete Internet e-mail address here. The address will be something in the form of 
myname@myprovider.com.
Note:

Please see your Internet provider’s documentation if you don’t know your full e-mail address.



If this option is selected, DiscPlay will automatically query the remote xmcd-cddb server whenever you insert an 
album it doesn’t recognize. It will automatically download the album’s title, artist, and track titles if they are 
available in the database.



These items allow you to specify which Internet search engine to use when you click “Search” under the WebLink 
menu.



If this option is selected, DiscPlay will not automatically query the remote xmcd-cddb server.
Note:

You can still query the server by clicking the Get From Internet button in the Add New Album wizard.



Click this button to show the previous step.



Click this button to show the next step.



Click this button to accept the settings you’ve entered and continue.



Click this button to close the window without saving the settings you’ve made.



If this item is checked, DiscPlay will display the time elapsed in the current track in all status displays.



If this item is checked, DiscPlay will display the time remaining in the current track in all status displays.



If this item is checked, an eject icon will appear in the notification tray. Click the icon to eject or retract the CD-
ROM drive’s tray.



If this item is checked, a stop icon will appear in the notification tray. Click the icon to stop playback.



If this item is checked, a play/pause icon will appear in the notification tray. Click the icon to start or pause 
playback.



If this item is checked, a previous track (rewind) icon will appear in the notification tray. Click the icon to move 
playback to the previous track in the playlist.



If this item is checked, a next track (fast forward) icon will appear in the notification tray. Click the icon to move 
playback to the next track in the playlist.



Click this button to show the previous step.



Click this button to show the next step.



Click this button to set the options and continue using DiscPlay.



Click this button to close the window without saving any settings you’ve changed.




